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Please note that this manual is written by the programmer.
Yes, we know! Not too clever. Probably there is a great lack of logic and you can be
sure that there’s missing a lot of information that the programmer thought was unnecessary to mention.
You can assume that there is a lot of spelling errors and gramatical errors as well.
If you find anything erroneous or any uncertanties please let us know and we’ll try to
explain the thoughts of the programmer. Please send your questions to
support@reconnector.com.

Infomaker Scandinavia AB

Sundsvall 2003-10-13
©2001-2003, Infomaker Scandinavia AB
This manual may be copied but not changed in any way.
All trademarks in this manual is copyrighted by their respective owner.
Portions ©1996-2000 Vertical Systems, Scandinavia AB, Dan Berghult
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What is Reconnector?

Automatically mount file server volumes at system start up
Reconnector connects automatically to the correct file server and mounts the chosen volumes
at startup. System requirments are a Power Macintosh with Mac OS 8.x, 9.x or 10.x
and Apple share 3.7 or higher version.

Automatic reconnection
A common problem is when the file server you are logged on to disappears from the desktop.
Reconnector solves that problem and reconnects you automatically as soon the file server is
available. This is a big problem especially with standalone computers (Application servers)
which should be connected to certain file servers to function properly.

Makes sure that applications startup and that they keep running
At startup it is common practice too have several applications launched after you
have connected to the correct file server(s). Reconnector connects and launches
the chosen applications. On top of that there is a useful function
keeping those applications up and running. If a certain application terminates by mistake or of
some malfunction, Reconnector will launch it again automatically.

As an alternative to the Chooser
Reconnector can also be used to connect to several file servers at once. By creating configurations for different users/groups, it is possible for these users/groups to log on at "their" specific file server in a user-friendly manor. This option suits users which travels a lot and need
access to different file servers depending on where they at.
This is very practical for the PowerBook user who often let their PowerBook sleep and don’t
shut it down.

Security and easy to use
Reconnector is very easy to install, administrate and use. You can password protect your configurations. The login and password information is encrypted in such way that no one can
move the configuration without the correct password.
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Installation and registration
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Installation and registration

1.

Copy Reconnector to a folder of your choice.

2.

Mac OS X:
If you want Reconnector to launch at startup, drag Reconenctor to Login items in the
Controll panel.
Mac OS 9:
If you want Reconnector to launch at startup, create an alias of it and put the alias into
the Startup Items folder in the Systemfolder.

3.

If you want any applications, documents or folders to be launched or opened at startup,
create aliases of these and put them in Reconnectors Startup Items folder. The Startup
Items folder is created when Reconnector launches the first time.
If you do this - Reconnector ensures that all volumes have been mounted on the desktop before any applications launches or document and folders are opened.

4

If you are installing Reconnector for the first time a registration window is opened.
There you fill in your name, company and serial number. Click OK and you are done.
You can order a valid serial number on our site: www.reconnector.com.

Reconnector Demo
If you want to evaluate Reconnector press the Demo button (This button gets activated after
10 seconds). The evaluation period is 14 days.
During the first 10 days of the evaluation period Reconnector behavs just as if it was an
ordinary licensed version. After 10 days Reconnector might occasionally throw up dialog
windows to inform that the current installation is a demo version. After 14 days Reconnector
will quit itself when being launched.
You can see by the orange color of Reconnectors main window that it is running in demo
mode.
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The contents of the Reconnector folder
The first time that Reconnector starts up it creates some
files and folders. If you can’t see these files and folders
you probably havn’t launched Reconnector.

Reconnector
The application itself.
Reconnector preferences
Reconnectors preference file is created by default in the
Reconnector folder.
If you prefer you can move it to the Preference Folder in
the System Folder. But before moving it make sure that
Reconnector isn’t running.
Configurations
This folder contains your configurations and it contains at
least one configuration file. By default a configuration file
is created when Reconnector launches for the first
time.Configurations can only be renamed from within
Reconnector.
A configuration file can’t be moved from one computer to
another computer unless you know that particular configurations password. All configuration files are encrypted and
can only be imported from within Reconnector. This rather
intricate behavior is to ensure that our AppleShare passwords and configurationfiles can’t end up in the wrong
hands.
Startup items
Any application, document or folder can automatically be
launched or opened at startup after that Reconnector has
mounted it’s AppleShare volumes.
To do this you create aliases of the applications, documents and folders and places these aliases in
Reconectors Startup items folder.
Don’t forget to put an alias of Reconnector in the Startup
items folder in the System folder.
Reconnector log.txt
This file contains log information can be of good help
when trying to pin down problems. The log files size if
configurable from within Reconnector.

Tip: Mac OS 9: Open the Startup items folder and drag it
down to the bottom of the screen so it collapses to a button.
By doing this you have a very nice shortcut to your
Reconnector Startup items.
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Updating Reconnector
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Updating Reconnector

1

Replace the old Reconnector application with the new one.

2

Remember to update any aliases that points to the older version of Reconnector.

3

If you are updating from Reconnector 1.x then you should put the content of the Startup
items into the Reconnector Startup Items folder and after you have done that, delete the
old Startup items folder.

4

If you update from reconnector 1.7 then you need to enter the Name, Company and
Serialnumber for Reconnector 2.0.
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Example 1: Application server

Reconnector 2.0, Rev A

Sid 10

Use Reconnector on an application server
What is an application server?
The way we see it, an application server is an unattended computer performing operations and
services.To function properly the applications server needs to have certain file server volumes
mounted on the desktop.

How do you use Reconnector on an application server?
You probably want Reconnector to mount server volumes at startup and you also want these
volumes to remount if the fileserver restarts or if there’s an network problem. You probably
want your applications to be started by Reconnector and that Reconnector launches these
applications if they are quit. We assume that you want Reconnector to restart the computer
each night to ensure that we have a fresh system every day.
You are probably not interested in having different configurations in this scenario.

How do I configure Reconnector in this case?
1

Mac OS X
Mount all server volumes that you want Reconnector to manage with the correct username and password using Go:Connect to Server ( -K).
Mac OS 9
Mount all server volumes that you want Reconnector to manage with the correct username and password using the Chooser.

2

Choose Volumes... from Reconnectors Edit menu.
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3

Select the volumes that you want to automatically mount. When you have selected the
volumes choose Auto mount from the Preference popup menu.

If you want more information regarding different options in the Preferences popup menu
please see the reference section of this manual.
4

Enter the password in the following dialog box. You have to enter a password for each
file server.

Note: All passwords are encrypted.

5

Click OK.

6

If you want Reconnector to launch applications and to open documents and folders create aliases of these objects and put the aliases into Reconnectors Startup items folder.

Note: You need to Deactivate/Activate Reconnector to make sure that
Reconnecor discovers the startup items.
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7

Choose Preferences... from the Edit menu.

8

Check the Auto activate with a count down checkbox to make Reconnector auto activate
itself when launched. A countdown window will appear allowing you to interupt the startup process. If you want you can modify how long Reconnectors count down will be.
If you have a bad network connection a longer countdown might be nedded to allow the
system to initiate AppleTalk or TCP/IP.

9

Select how long time Reconnector will wait before launching the Startup items. A long
wait time might be necessary if large volumes of fonts are being loaded by fontmanagement software. The long wait will make sure that the Startup Items aren’t launched until
the fonts are loaded.
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10

Select Restart computer from the Don’t shutdown or restart popup menu and enter a
time when you want the computer to be restarted. The delimiter between hours and
minutes depends on what the current time format is in the computer. Look in the
Systems Date and Time control panel to be sure of what to use.
11

Press OK.

Note: Don’t forget to put an alias of Reconnector in the Startup items system folder (Mac OS
9) or in Login items in the control panel in Mac OS X.
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Example 2: Single user
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How to use Reconnector as a single user
How do you use Reconnector as a single user?
As a single user of Reconnector you probably want to use Reconnector to remember all your
file server volumes. Maybe you travel a lot and uses your computer in various networks with
various file server volumes and want to be able to mount these file server volumes as simple
as possible.
You probably don’t want Reconnector to open applications, folders or documents for you.
Maybe you want to be able to manually open applications from within Reconnector.

How do I configure Reconnector in this case?
1

Mount all server volumes that you want Reconnector to manage with the correct username and password using the Chooser.

2

Choose Volumes... from the Edit menu from within Reconnector.
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3

Select the volumes that you want to automatically mount and remounted. When you
have selected the volumes choose Auto mount from the Preference popup menu.

If you want more information regarding different options in the Preferences popup menu
please see the reference section of this manual.
4

Enter the password in the following dialog box. You have to enter a password for each
file server.

Note: All passwords are encrypted.

5

Click OK.

Create a new configuration
6

If you want different sets of file server volumes to choose from then you have to create a
new configuration. Choose Configurations... from the Edit menu.
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7

There is no command to create a new Configuration. Instead you duplicate an existing
one.
Select the configuration you want to duplicate then click on the Duplicate... button.

8

Give the new Configuration a name. This name can be changed later on.

9

Click OK.

10

Select the new configuration and make it the active configuration by pressing the
Activate button. The window Configurations will now close.
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Password protect a configuration
11

Open the window Configurations again.

12

Select the created configuration and click on the button Password...

13

Leave the Old password field empty.
Enter your password in the New password field and then enter the password in the
Verify password field.

14

Click OK.
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Create shortcuts in the Apple menu (Mac OS 9)
15

Open the folder Apple menu that resides in the System Folder.

16

Create a new folder called Reconnector in the Apple menu folder. (The name is just an
example.)

17

Create an alias to each configuration that you want to show up in the Apple menu and
place the aliases in the Reconnector folder that is in the Apple menu folder.
The configurations are found in the folder Configurations in the same folder as
Reconnector.

18

It might look something like this in the Apple menu.

By doing this it is very easy to change Reconnector Configuration.
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Setting the Preferences
19

Open the Preference window by choosing Preferences... from the Edit menu.

20

Click on the Switching tab.
If wanted, activate Dismount all AppleShare volumes. This means that if you choose
another configuration, all connected AppleShare volumes will be disconnected.
If Mount volumes is activated Reconnector will attempt to mount all corresponding volumes.
If Quit Reconnector after switch is activated, Reconnector will quit after mounting volumes predefined in the choosen configuration.

21

Click OK.

Tip: If you want to see a different configuration’s Volumes, you can open both the
Configurations windows and the Volumes window. In the Configurations window you can
double click on each configuration to see it’s corresponding Volumes settings..
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How do I use Reconnector?
Reconnector can be used in two ways.
1

You can mount volumes one by one, switch configurations and start applications from
Reconnectors main window.

2

You can switch configuration and all corresponding volumes will be mounted automatically.

What can I do in Reconnectors main window?
In Reconnectors main window there’s a popup menu from which you can execute some of
Reconnectors commands.

Mount all

-Shift-M
Mount all volumes in the current configuration

Dismount all

-Shift-D
Dismount all volumes that are currently mounted.

Configuration
You can change configuration thru this submenu.

Mount
Mount a volume from this sub menu.

Dismount
Dismount a volume from this sub menu.

Launch
Launch an application of your choice. This assumes that
you have placed at least one application alias in the folder
Startup items located in Reconnectors folder.
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Working from the Apple menu
Assuming you have created an alias of the configurations folder and placed it in your Apple
menu, you can easily choose and change the configuration you wish to work with simply by
selecting it from the Apple menu. You can also select the configuration that is already choosen
to mount the predefined volumes.
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WORKING WITH RECONNECTOR IN MULTI
USER ENVIRONMENT
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Working with Reconnector in multi user environment
Working with multiple users is very similar to working as a sole user.
The difference is that you in the multiple user case probably are working stationary and have
created one configuration for each user.
Different users probably prefer to change configuration thru the Apple menu as described in
the previous chapter. You could say that different configurations are different users.
It is also very likely that the users themselves are not responsible for creating and setting up
their configuration. It’s most likely done by someone that administrates that computer.
Let’s assume that Reconnector won’t be started automatically and that it shall not launch any
applications either.
Remember that if you want the user X and the user Y to connect with their own users when
selecting their configuration you have to connect with their specific user name when setting up
Reconnector

How do I configure Reconnector in this case?
1

Connect to all the volumes you want Reconnector to handle using the Chooser.

2

Choose Volumes... from the Edit menu.
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3

In the Volumes window, select the volume you wish to have mounted upon startup and
to be remounted in case you are disconnected. Then choose Automount from

If you want more information regarding different options in the Preferences popup menu
please see the reference section of this manual.
4

Enter the password in the following dialog box. You have to enter a password for each
file server.

Note: All passwords are encrypted.

5

Click OK.

Create a new configuration
6

If you want different sets of file server volumes to choose from then you have to create a
new configuration. Choose Configurations... from the Edit menu.
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7

There is no command to create a new Configuration. Instead you duplicate an existing
one.
Select the configuration you want to duplicate then click on the Duplicate... button.

8

Give the new Configuration a name. This name can be changed later on.

9

Click OK.

10

Select the new configuration and make it the active configuration by pressing the
Activate button. The window Configurations will now close.
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Password protect a configuration
11

Open the window Configurations again.

12

Select the created configuration and click on the button Password...

13

Leave the Old password field empty.
Enter your password in the New password field and then enter the password in the
Verify password field.

14

Click OK.
Repeat step 1 to 14 for each configuration you want to create. If you want each configuration (user) to logon to the fileserver using it’s own AppleShare username and password then you must logon to the server with the Chooser for each user/configuration you
are creating If you don’t then each configuration will use the same username and therefore get the same priviligies.
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Create shortcuts in the Apple menu (Mac OS 9 only)
15

Open the folder Apple menu that resides in the System Folder.

16

Create a new folder called Reconnector in the Apple menu folder. (The name is just an
example.)

17

Create an alias to each configuration that you want to show up in the Apple menu and
place the aliases in the Reconnector folder that is in the Apple menu folder.
The configurations are found in the folder Configurations in the same folder as
Reconnector.

18

It might look something like this in the Apple menu.

By doing this it is very easy to change Reconnector Configuration.
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Setting the Preferences
19

Open the Preference window by choosing Preferences... from the Edit menu.

20

If wanted, activate Dismount all AppleShare volumes. This means that if you choose
another configuration, all connected AppleShare volumes will be disconnected.
If Mount volumes is activated Reconnector will attempt to connect all corresponding
volumes
If Quit Reconnector after switch is activated, Reconnector will quit after mounting volumes predefined in the choosen configuration.

21

Click OK.

Tip: If you want to see a different configuration’s Volumes, you can open both the
Configurations windows and the Volumes window. In the Configurations window you can
double click on each configuration to see it’s corresponding Volumes settings..

Reconnector 2.0, Rev A

Sid 31

How do I use Reconnector?
Reconnector can be used in two ways.
1

You can mount volumes one by one, switch configurations and start applications from
Reconnectors main window.

2

You can switch configuration and mount corresponding volumes directly from the Apple
menu. This is probably the easiest way to use Reconnector in a multi-user environment
in Mac OS 9.

What can I do in Reconnectors main window?
In Reconnectors main window there’s a popup menu from which you can execute some of
Reconnectors commands.

Mount all

-Shift-M
Mount all volumes in current configuration

Dismount all
-Shift-D
Dismount all volumes that are currently connected
Configuration
Thru this sub menu you can easily switch configuration
and check which configuration that is currently active.

Mount
Mount a selected volume from this sub menu.

Dismount
Dismount a selected volume from this sub menu.

Launch
Launch an application of your choice. This assumes that
you have placed at least one application alias in the folder Startup items located in Reconnectors folder.
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Working from the Apple menu
Assuming you have created an alias of the configurations folder and placed it in your Apple
menu, you can easily choose and change the configuration you wish to work with simply by
selecting it from the Apple menu. You can also select the configuration that is already choosen
to mount the predefined volumes.
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REFERENCE
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Reference
This is a complete description of all menues, commands and all the windows in Reconnector.

The Apple menu/Reconnector menu

About...
Show Reconnector About-window.

Register...
This window is used for registration of Reconnector. Fill in name, company name and
serial number completes the registration. To obtain a valid serial number contact
Infomaker at sales@infomaker.se
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The File menu

Mount all

-Shift-M
Mounts all volumes in the chosen Configuration.

Dismount all

-Shift-D
Dismounts all Apple Share volumes that are active in the desktop.

Show log

-L
Shows the log file in the log window. Be aware of the fact that, the log window shows
the last 31000 characters. To read the complete log file you need to open it with an ordinary text editor like BBedit or Tex-Edit.

Quit

-Q
Quits Reconnector.
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Edit-menyn

Activate

-H
Reconnector has to be in active mode to automatically reconnect dropped volumes and
to launch applications that needs to be launched.. When Reconnector is in active mode
the Activate option at the Edit menu it changes to Deactivate.

Deactivate

-H
Pauses Reconnector.
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Volumes...

-E

Open the window Volumes.

The Volumes window shows all mounted AppleShare volumes that currently are on the
desktop plus the volumes that you have told Reconnector to handle. All commands in
this window can be performed with more than one volume.

Preference
Each volume has it’s own Preference. Preference controls how a volume should be
handled. When you choose any other preference then Not handled you must enter the
AppleShare password.

Not handled
The volume is not handled by Reconnector. This is the default preference for the volume.
By choosing this preference you can also make sure that a wrongly entered password is
erased.
Auto mount
If you want Reconnector to automatically keep volumes mounted then choose this preference. You must also choose this preference if you want Reconnector to function properly if you use Configurations to mount volumes.
Manual mount
Choose this preference if you only want to be able to mount volumes manually from
Reconnectors main window.
Paused
If you know that an AppleShare server is going to be stopped temporary then you might set
the preference to Paused to stop Reconnector from trying to mount the volume. When you
do this Reconnector remembers the password so that you can change back the preference
to Atomount when the server is running again.
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Remove...

-X
Removes the selected volumes from the volumes list.

Refresh

-R
Refresh is used to update the volumelist. You can also do this by closing and opening
the Volumes window.

Mount volume

-M
Mounts the selected volumes from the volumes list. We recommend that you do this to
verify that you have entered the right password. You need to dismount the volume before trying to mount it.

Dismount volume

-D
Dismount selected volumes.
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Configurations...

-K

Opens the Configurations window.

This window is being used to change and administer configurations.
You can’t create new configurations but you can duplicate existing ones.
When Reconnector is launched for the first time a default configuration is created automatically.
You can use -A to select all configurations.

Duplicate

-D
Duplicate the selected configuration. When you do this you must enter a name for the
new configuration.

Delete

-X
Delete the selected configurations. This can’t be undone. You can’t delete the active
configuration.

Import

-I
Import a configuration from another users computer.If the imported configuration is password protected a dialog will prompt you to enter the password.
If the configuraion isn’t password protected then all AppleShare passwords will be deleted. All volumes in the Volume window will have the preference Not handled.
This is done to ensure that configurations can’t be moved or copied without permission
or knowledge of the appropriate passwords.
Note that all passwords are encrypted in Reconnector.

Change name

-C
Change the name of a configuration.

Password

-P
Password protect or change the password of a configuration.
You can only change the password of the active configuration.
Enter
Activate the selected configuration.

Activate
Done

-. or ESC
Closes the Configurations window without changing configuration.
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Preferences...
Opens the Preferences window.

Startup: Activation
To let Reconnector activate itself after being launched you must check the Auto activate
checkbox. You should also set a valid countdown time.

Startup: Startup items Wait
You can set how long Reconnector should wait, after it has mounted the volumes, before Reconenctor launches the Startup items.

Startup: Keep applications alive
If you set this checkbox, Reconnector will make sure that all the applications that has an
alias in the Startup Items Folder are running. If you quit an application while
Reconnector is active, Reconnector will try to launch that application again.
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Shutdown: Don’t shutdown or restart
Just what it sounds like.

Shutdown: Shutdown computer at
This ensures that the computer is turned off at a certain time.

Shutdown:Restart computer at
This restarts the computer at a certain time.
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Dismount all AppleShare volumes
When selected and when someone changes configuration all AppleShare volumes that
currently are on the desktop is unmounted. This is done to ensure that only the volumes
in the configuration is mounted on the desktop after a configuration switch.

Mount volumes
When selected and when someone changes configuration the volumes in the new configurations is mounted.

Quit Reconnector after switch
When selected and when someone changes configuration Reconnector is quit.
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Miscellaneous: Use ping
This setting should normally always be selected. By selecting this you ensures that
Reconnector won’t try to mount a volume until the volume really is available.

Miscellaneous: Maximum log
Sets how maximum size of the Reconncetor logfile.

Miscellaneous: Hide Reconnector window
Hides Reconnectors main window.
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